
The ITS Help Desk, located in 108 Allen Hall, is a service provided 
to all Mississippi State University faculty, staff, and students. The 
ITS consultants are available to help with various computer-related 
problems, as well as provide answers to computer and technology-
related questions. Visit the Web site at www.its.msstate.edu for 
handouts and resolutions to common computer problems. If you 
cannot find an answer to your question on the Web or you do not 
have access to the Internet, please call at 325-0631 (8:00 a.m. to 5:00 
p.m. Monday through Friday). You may also contact the ITS Help 
Desk by email at helpdesk@msstate.edu.

OBJECTIVES

Getting Help

Instructor

Introduction to Adobe Acrobat X
The Portable Document Format (PDF) is a computer file format developed by 
Adobe Systems. The operative word is portable; Adobe developed PDF so any 
kind of document created on any kind of computer can be viewed exactly as it 
was designed - no need for the user to have the original authoring application.

What this means is that an electronic document - such as a Microsoft 
Word file, an Excel chart, a PowerPoint 
presentation or an AutoCAD drawing — 
will look the same on a user’s computer 
as it did on the original author’s computer. 
PDF enables a document author to 
include all fonts, images and other design 
elements in the file so users don’t need to 
have these elements on their computers in 
order to view the original design. These 
elements are embedded in the document 
so visual integrity can be maintained.

●	 Save a document as a PDF

●	 Combine PDF files into one 	
	 document

●	 Add comments to a PDF

●	 Make changes to a PDF

●	 Redacting a PDF

●	 Document security
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About Adobe PDF

Adobe Portable Document Format (PDF) is a universal file format that preserves all of the fonts, formatting, 
colors, and graphics of any source document, regardless of the application and platform used to create the 
original document. Adobe PDF files are compact and secure. Anyone using the free Adobe Reader can view, 
navigate, comment on, and print a PDF file. There is also the option to extend additional rights to Adobe Reader 
users, allowing them to fill in and save a PDF form, and to participate in PDF review processes. Acrobat Pro 
users can also enable Reader users to digitally sign a PDF.

●  	 Adobe PDF preserves the exact layout, fonts, and text formatting of electronic documents, regardless of the 
computer system or platform used to view these documents.

●  	 PDF documents can contain multiple languages, such as Japanese and English, on the same page.

●  	 PDF documents print predictably with proper margins and page breaks.

●  	 You can secure PDF files to prevent unauthorized changes or printing, or to limit access to confidential 
documents.

●  	 You can change the view magnification of a PDF page in Acrobat or Adobe Reader, which is especially use-
ful for zooming in on graphics or diagrams containing intricate details.

Almost any document - a text file, a file created in a page-layout application, a scanned document, a web page, 
or a digital photo can be converted to Adobe PDF using Acrobat software or third-party authoring applications.  
The workflow and document type determine the best way to create a PDF.
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What if I only have Adobe Reader?
Adobe Reader, available free online, is the global standard of reviewing PDF files. It is the only PDF viewer that 
can open and interact  with all PDF documents. Adobe  Reader makes it possible to view, search, digitally sign, 
verify, print, and collaborate on PDF files without have Acrobat Pro installed. 

Adobe Reader can natively display rich media content, including video and audio files. You can also view PDF 
Portfolios in Reader. New in Adobe Reader X, anyone can comment on PDF files using the Sticky Note and 
Highlight tools that are built into the application. However, you can extend additional rights to Adobe Reader 
uses if you want them to be able to complete a PDF form or participate fully in collaborative document reviews.

By default, Adobe Reader for Windows opens PDF files in Protected Mode, also known as sandboxing. In 
Protected Mode, Reader confines any processes to the application itself, so that potentially malicious PDF files 
do not have access to your computer and its system files. To verify that Adobe Reader is in Protected Mode, go 
to the File pulldown menu and choose Properties. Select the Advanced tab and view the Protected Mode status. 
It is recommended that your keep this default setting on your computer.

Accessibility features, including the Read Out Loud feature, may not work in Adobe Reader in Windows XP 
when Protected Mode is enabled. In Windows Vista and Windows 7, the accessibility feature should work.

PDFs on the Web
The web has greatly expanded the possibilities for delivering electronic documents to the wide and varied 
audience. Because web browsers can be configured to run other applications inside the browser window, PDF 
files can be posted as  part of the website. Visitors to can download or view the PDF files inside the browser 
window using Adobe Reader.

PDFs can be viewed one page at a time and printed from the web. With page-at-a-time downloading, the server 
sends only the requested page, decreasing downloading time. In addition, selected pages or all pages can be 
easily printed from the document. PDF is a suitable format for publishing long electronic documents on the web, 
and PDF documents print predictably, with proper margins and page breaks.
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Top Twelve Features of Acrobat X
1.	 Word or Excel to PDF Convert PDF files with one-button ease in Windows® 

from Microsoft Office applications, including Word, Excel, Access, 
PowerPoint, Publisher, and Outlook — without ever leaving your authoring 
application.

2.	 PDF to Word or Excel  Reuse content from PDF documents to get a head 
start on new projects. Save PDF files as Microsoft Word or Excel files, 
retaining layouts, formatting, and tables.

3.	 Creating PDF Portfolios   Assemble a wide range of materials — including 
spreadsheets, web pages, videos, and more — into a single, polished PDF 
Portfolio for high impact. Easily customize PDF Portfolios to reflect your 
branding and style.

4.	 Adding rich media  Quickly bring ideas to life through rich, interactive 
documents. Insert audio, Adobe Flash Player compatible video, and interactive 
media into PDF files for seamless playback in Adobe Reader 9 or X.

5.	 Streamlining PDF tasks   Automate routine, multistep tasks as a guided 
Action with the Acrobat Action Wizard. Create, manage, execute, and share 
a sequence of frequently used steps that can be applied to a single PDF or 
batches of files.

6.	 Online document reviews   Gain the feedback you need more quickly through 
easy-to-manage, shared document reviews that allow participants to see and 
build on one another’s comments. Easily track progress and participation, add 
reviewers, and email updates or reminders.

7.	 Creating fillable forms  Easily collect data by creating fillable PDF forms 
from paper or existing electronic files with the Acrobat Form Wizard. Quickly 
distribute forms, track status, and analyze results.

8.	 Extending Reader functionality   Enable Adobe Reader 9 or X users to 
participate in shared reviews, fill and save forms, and digitally sign and 
approve PDF documents — regardless of platform or operating system.
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9.	 Version comparison   Eliminate confusion and improve version control. 
Easily identify differences between two versions of a PDF file by having 
Acrobat analyze both files and highlight changes to text and images.

10.	 Removing and redacting information    Use redaction tools to permanently 
delete sensitive information, including specific text and illustrations. Easily 
sanitize documents by finding and deleting hidden information with a single 
click.

11.	 Standards support   Create documents that conform to PDF/A, PDF/E, and 
PDF/X ISO standards, and fix those that do not. Check and adjust documents 
to ensure that they are accessible to people with disabilities.

12.	 Online file sharing   Use Adobe SendNow online services from within 
Acrobat to send, share, and track large files without the headaches of email 
size restrictions, FTP sites, and costly overnight services.

Taken from: 	 http://www.adobe.com/products/acrobatpro/features._sl_id-			
	 contentfilter_sl_featuredisplaytypes_sl_top.html
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Acrobat Tools
The pulldown menus  (i.e., File, Edit, View) are positioned across the top of the Acrobat window. Other shortcut 
icons reside in the rows below the pulldown menu. All of the shortcut icons are also available in the pulldown 
menus.  The menu bars below the pulldown menus may be customized by adding or removing more or lesser 
used icon shortcuts. On the right side of the menu bar are Tools, Comment, and Share that appear as a panel 
when chosen.

Create a PDF
1.	 Open the Word document  named Owning_Ideas.doc located in your file 

resources. 

2.	 Go to the File tab. There are two different ways to create a PDF.  

3.	 Choose Save as Adobe PDF or select Print, under Printer choose Adobe 
PDF. 

4.	 Navigate to where you want to save the file and save.
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Opening a Document
Acrobat, like many applications, has several ways of doing the same thing. 

1.	 To open a document, go to the File pulldown menu and choose Open or choose Open from the 
Welcome Screen. 

2.	 In the Open window, navigate to your Desktop and 
double click on the Temp folder. Choose Owning_Ideas.
pdf and click Open.

3.	 With the document open, we will navigate through the 
menus and functions available in Acrobat.

4.	 When the file is open, you can choose from several 
viewing options.

	 In Full Screen Mode, you see only the document - no 
menus, toolbars, or windows. To release Full Screen 
Mode, press the Esc key.

	 If you prefer to keep things in a window, but will less 
clutter, select Reading Mode. This allows the PDF to be in the window, but removes all the toolbars.

	 For additional page views, go to the View pulldown menu and choose Page Display. 
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5.	 Navigating through a page or document is quick and 
efficient with the Acrobat Navigation Tools. These tools 
can be enabled or disabled from the View pulldown 
menu, then select the Toolbars submenu.

	 Zoom Tools
	 Zoom tools are found in the menu bar at the top of the Acrobat window. You may 

enter a zoom amount, choose a pre-set percentage from the pulldown menu, or 
use the plus and minus button for incremental zooming.

	 Page Navigation
	 Acrobat allows you to navigate through the document 

several ways. You may enter the page number or select 
the Thumbnails icon. Double click on the page and you 
are taken directly to it.
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Adding Comments
One of the longest standing features in Acrobat is the ability to add comments to a PDF document. Originally, 
these comments were simple, electronic sticky notes that a reader could attach to the page. The PDF annotation 
mechanism has since grown to include a broad set of highlighting, drawing, and other tools that you can use to 
do full featured commentary on a document. Additionally, there are tools for reading and summarizing these 
comments, and even for conducting a document review involving your entire workgroup or office (Deubert, 
2009).

Commenting Tools

Acrobat’s commenting tools are accessible in three locations:

●	 The View pulldown menu 
●	 The Quickview menu
●	 The Comment tab which contains submenus for all the comment tools



10

Adding Comments
1.	 Navigate to the PDF  named Owning_Ideas.pdf. 

2.	 A word in the title needs to be changed. You will highlight the word that needs changing, then create a 
Sticky Note explaining what word needs to be changed and what the change should be. 

	 Go to the Tools pulldown menu, select Comment & Markup, and choose Show 
Comment & Markup Toolbar located at the bottom of the menu. The Comment & 
Markup Toolbar should appear. 

	 Select the Highlight tool.

3.	 Using the Highlight tool, select the word “An” in the title on the first 
page. The word becomes highlighted and when the user hovers over the 
word, the NetID of the person who created the highlight appears if the 
user has authenticated onto the network. (This feature does not work in 
the lab environment.) 

4.	 To add a comment with a Sticky Note, select the Sticky Note tool. The cursor turns into a Sticky Note 
Icon. Click near the highlighted word and the icon imbeds in the document creating a Sticky Note box 
where the user writes comments, changes, suggestions, etc. In this example, I wrote to change the “An” 
to “The”. 
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More Ways to Add Comments
In addition to the more common methods of adding comments to a PDF. 

1.	 Select the Comments tab in the upper right portion of the window. 
The Comments section contains the tools for making comments and 
sharing documents. Under the Annotation dropdown menu, the two 
earlier comment tools, Sticky Note and Highlighter, are seen. The 
Attachment tool is available in this location as well as in the left 
section of the PDF window under Bookmarks. The Record Audio 
tool allows the reviewer or originator to make a recording, with the 
appropriate equipment (microphone). 

2.	 To make an Audio Comment, click the Record Audio icon, the click 
inside the PDF where you want the comment to appear.

3.	 The cursor now appears as a recording icon. 
Click again and the Sound Recorder window 
appears. At this point, you can click the 
red button to begin recording if you have 
a microphone, or browse to find an audio file to attach. If you are 
recording a message, click OK when the message is complete.

4.	 The Sound Attachment Properties window appears. You have the option to customize the icon. Click 
OK when your selections are completed.

5.	 Click on the audio icon to hear the message.
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Review
The Review tool allows you to send a document to others for review. 
Through Adobe.com, the document can be tracked.

To begin, the document must be saved before it can be sent for 
review. 

Click the Send for Shared Review icon to start the process.

The next step, you enter the email addresses of the 
reviewers. The review will receive an email with a URL 
link to the document. Anyone with the URL will have 
access to the document.
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In your PDF file, a window shows that you can track the shared reviews. 

The email the reviewer receives contains a link to the 
document. Click the link to access the document.

A new browser window opens and the reviewer is allowed 
to download the PDF or Open it. 

If Open is selected, the document opens in the browser 
and the Comment tools are available for the reviewer. 
Once the reviewer has completed all comments, s/he may 
check for new comments or publish the comments just posted.
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Once a new comment has been made, click Publish Comments and they are saved. In the comments list, the 
new comment is time stamped and bookmarked in the document. In addition, the deadline to add comments is 
posted at the top of the document so the reviewer is aware of any time limitations. 

When all comments are made by all reviewers, the document can be downloaded and the comments saved.

When the original PDF is opened, it shows that one new comment has been posted.
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Also in the Review section, there is Send for Email Review which 
allows the document to be sent via email to whomever needs to review 
it. Collaborate Live and Track Reviews also allow multiple review 
options. You will need an Adobe.com account to use these features.

Tools

Pages

The Pages section of Tools allows you to do a variety of functions to the page 
ordering and design. 

The Rotate tool allows a page or pages to be rotated in increments of 90 degrees. 
This tool is useful if there are charts that have a landscape orientation or if a 
scanned document is upside down.

The Delete tool is used to delete selected pages from the document.

The Extract tool allows a selected page to be extracted. The page can be deleted 
after it is extracted or it can be saved as a separate file. 

The Replace tool can be used to replace a document. For example, if the 2010 
annual report needs to be replaced by the 2011 annual report. The tool is capable 
of this function.

The Crop tool is utilized to take away part of a page or pages in a document. The 
area is selected, then press delete to complete the function.

The Split Document tool allows a document to be divided into multiple 
documents as well as reduce file size. Bookmarks within the PDF will also 
remain in tact.
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Tools

Pages

Insert Pages Section

Using the Insert from File tool allows you to insert another PDF. More Insert 
Options include the ability to Insert from Clipboard, Insert from Scanner 
with additional options with that option, Add to PDF from Web, and Insert 
Blank Page. 
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Combining PDF documents
1.	 With the Owning_Ideas.pdf document open, go to the Tools Tab, under the Pages Heading and Insert 

Pages heading, choose  Insert from File. 

2.	 Navigate to the Understanding the issue.pdf 
document located in your Temp folder, click 
on it to select it, then click Select. 

3.	  The Insert Pages dialog box appears. Select 
After, in the Location field, and 10 in the 
Pages field. Click OK. 

4.	 The page 
has been inserted 
at the end of your 
document.
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Tools

Pages

Edit Page Design

This group of tools allows you to add elements to your existing PDF. In 
this group of tools, you can add Headers & Footers, a Background, a 
Watermark, and Bates Numbering. (Bates Numbering is used in the 
legal, medical, and business fields to place identifying numbers and/or date/
time-marks on images and documents as they are scanned or processed (for 
example, during the discovery stage of preparations for trial or identifying 
business receipts). Bates stamping can be used to mark and identify images 
with copyrights by putting a company name, logo and/or legal copyright on 
them. This process provides identification, protection, and auto-increment 
numbering of the images. “Bates Numbering Legal Documents”. Infordesk’s 
ParmisPDF. March 11, 2010)
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Tools

Content

The Add Bookmark and Attach a File are also available on the left side of the 
PDF. 

Edit Text & Objects

These editing tools can be extremely useful if you do not have access to the 
original file (eg. Word file). In addition, you can Edit Object which consists of  
selecting, moving, and deleting an object (or text box). Users are also able to 
Add or Edit Text Box. 

Add or Edit Interactive Object

These tools are used to add links and accessibility to interactive objects such as 
web pages, video, audio, and more.
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Making Changes within the PDF
1.	 Users are able to make editing changes within a PDF with several 

different editing tools. Go to the Tools tab and choose the Content 
submenu. pulldown menu, click Advanced Editing, and choose 
Edit Document Text. 

2. 	 Click the cursor next to the word An in the document. A warning 
window may appear regarding font compatibility. Click OK. 

3.	 With the cursor next to the letter n. The easiest way to make PDF text changes is to type the new 
word, then delete. This method avoids formatting issues that are sometimes present when editing PDF 
documents. Type The, then delete An. 

4.	 To hide the comments and highlight, click the Comments List to view the 
tools and select the icon that looks like a callout box. In the dropdown menu, 
choose Hide All Comments. Do the opposite to view comments.
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Navigating within the PDF
1.	 In the left side panel of the Owning Ideas PDF, are four icons.

2.	 Select the first icon to show thumbnails of the document.

3.	 Click on any page in the list to go to that page.

Another method of navigation is Show Next Page icon.

1.	 Use the up and down arrows to navigate 
through the document. You may also enter the 
page number, if known, in the field.

The next method of navigation is using the Hand Tool.

1.	 Select the Hand Tool. Click, hold, and drag to navigate through PDF pages.
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Bookmarks
1.	 The Bookmark Tool allows links to specific points of interest within 

the PDF. Select the Bookmark Tool.

2.	 Scroll down to page two. Highlight the section title Copyright Law. 

3. 	 Click the New Bookmark icon. A bookmark appears in the column bearing the name of the highlighted 
title.

4.	 Scroll down to page four and highlight Patent and repeat the same steps as above.

5.	 Go back to page one. Click on one of the bookmarks you just create and see how you are taken directly 
to that part of the PDF.
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Comment Spell Check
	 Acrobat has a built-in spell check that looks 

for spelling errors in a document’s comments 
and form fields. This feature is located in the 
Edit pulldown menu. Select Check Spelling, 
then In Comments. The Check Spelling 
dialog appears, press Start to begin the 
process. Acrobat examines all the comments 
and form text fields in your document, looking 

Allowing Comments in Adobe Reader
	 By default, PDF documents cannot be modified in any way with the free Adobe Reader. Unfortunately, 

this ban includes attaching comments to a file. If you want people to be able to review your document in 
Adobe Reader, you must turn on this capability for the document.

	 Once your PDF document has been enabled for commenting in Reader, you are now somewhat 
restricted in what you can do to the document. Even if you are examining the file in Acrobat Standard 
or Pro, you can no longer shuffle pages, edit page content, add form fields or links, or otherwise modify 
the document. This will remain until you disable Acrobat’s 
ability to annotate in Adobe Reader.

	 To enable a document for commenting in Adobe Reader, go 
to the Comments pulldown menu and choose Enable for 
Commenting and Analysis in Adobe Reader. Acrobat 
presents a dialog box warning that file editing will be 
restricted. Then a Save dialog box opens, because Acrobat 
insists that you resave the Reader-enabled file. 
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Adding a Watermark
	 A watermark is text or graphics that are placed on a page either in front 

of or behind the page’s contents. Adding a watermark prevents others 
viewing the document from using the document before it is ready or letting 
others know the document is still in proof stages or is confidential. To add a 
watermark to a document:

1.	 Go to the Tools section and choose Watermark, then Add Watermark.

2.	 The Add Watermark dialog box appears. Check the Text radio button in 
the Source section. Enter the word Confidential. As you type, it appears in 
the document preview.  

	 In the Appearance section, select 45°, change the Opacity to 50 or below, 
check the Scale relative to target page at 50%, and check the radio button 
next to Appear behind page.

	 Click OK. The Watermark appears within the document. By clicking 
Apply to Multiple you can add the same watermark to multiple documents.
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Creating Forms
1.	 Open the PDF named LEAVE FORM located in your Temp 

Folder on your desktop. 

2.	 In the Tools section, under the Forms heading, select the 
Create icon.

3.	 In the Create or Edit Form window, select Use an existing file 
and click Next. 

4.	 In the next window, select Use the current document, 
which is the leave form. Click Next. 
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5.	 Because the document had blank lines and we chose 
a tool in the Forms section, Acrobat automatically 
detected fields and named them. You can go through 
the document and edit the fields. 

6.	 Double click on the first field in the form next to 
Name of Employee. A Text Field Properties window 
appears. In this window, you can edit the field 
properties. Change the field to Name. 
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Action Wizard

The functions available in the Action Wizard take you step-by-step through a 
pre-defined process. For example, you have the ability to create an accessible 
PDF by following the steps of the action. 

Recognize Text

If you have a scanned document, this tool will create text in the document that  
you can then edit. This is a great tool to use if you only have a paper copy of a 
document that needs changes or you just want to have an electronic version of 
it. The OCR Suspects finds unrecognizable words that you can edit. 
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Protection

These tools are used to ensure documents are secure 
if necessary. The Encrypt tool has several options: 
Encrypt with Certificate and Encrypt with 
Password. To Encrypt with Certificate, you must 
create a certificate, then you or the person you send it 
to must have the certificate to open the PDF. The more 
common protection method uses password protection. 
Within the Password protection function, there are several options available.

1.	 Choose Encrypt with 
Password. 

2. 	 Acrobat asks if you are certain 
you  want to change security 
settings for the document. Click Yes.

3.	 In the Password Security Settings window, complete the steps to 
create your password.

4.	 You can choose options that require the 
password to open the document and also to 
restrict editing of the document. You must 
remember the password because there is no 
password recovery options within Acrobat. The 
strength of your password is rated as well.

5.	 The password protected PDF will prompt the 
person opening the document for the password 
and will not open unless it is correctly entered.
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Redaction

Whenever the courts make documents public or law offices are required to produce 
documents that contain potentially confidential or privileged information, redaction 
may be applied to the documents to hide such information. This is true for documents 
containing student information at MSU. This tool can be used to protect both the 
student and the university from information security issues. 

1.	 In the open PDF, click the Mark 
for Redaction tool. A dialog box 
containing information about using 
the redaction tool appears. Click OK 
when you have read the information. 

2.	 The text you select with your cursor 
is contained in a red box. Once you 
have selected all the text to redact, click Apply Redactions. The redactions 
are permanent within the PDF.

3.	 Once the redactions 
are applied, you 
are prompted to 
remove hidden 
information from 
your document. 
Click Yes and 
Acrobat shows 
what hidden 
information was 
found and you have the choice of 
removing it.
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Redaction

In addition to manually selecting text to redact, you can also Search & Remove 
Text. 

Sanitize Document

The Sanitize Document tool will remove hidden data and metadata from your 
document. When you click this tool, a dialog box appears explaining what will be 
removed.
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Digital Signatures

A digital signature, like a conventional handwritten signature, identifies 
the person signing a document. Unlike a handwritten signature, a digital 
signature is difficult to forge because it contains encrypted information that 
is unique to the signer and easily verified. 

To sign a document, you must obtain a digital ID. The digital ID contains a 
private key that is used to add the digital signature and a certificate that you 
share with those who need to validate your signature.

1.	 Go to the Edit pulldown menu and choose Preferences. 

2.	 Choose Security from the categories. 

3.	 If you click New, you can add a logo or other graphic to your 
signature. Use your name for the title.

4.	 In the Configure Text section, choose the elements you want to appear in your signature.

5.	 When you are  happy with your signature block, click OK.
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Digital ID

A digital ID is similar to a driver’s license or passport. It proves your identity to people with whom you 
communicate electronically. A digital ID usually contains your name and email address, along with the company 
that issued your ID, a serial number, and an expiration date.

1.	 Under the Protection heading in the Tools pane, choose More Protection, and then Security Settings. 

2.	 In the Security Settings dialog box, select Digital IDs, then Add ID. 

3.	 In the Add Digital ID window, select A new digital ID I want 
to create now. Click Next. 

4.	 Select New PKCS#12 digital ID file and click Next. 
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5.	 In the Add Digital ID window, enter your personal 
information. Enter your name as you want it to appear in 
the signature, your department name, and email address.

6.	 Choose 1024-bit RSA from the Key Algorithm menu. 
This level of security is more universally compatible than 
the other choice. 

7.	 In the Use digital ID for menu, you will use the Digital 
Signature more than the other choices because the other 
choices require you to specify trusted recipients. Click 
Next. 

8.	 In the next window, you can keep the default file name 
location or enter another. In the Password fields, create 
a password that you will not forget. Acrobat rates the 
strength of your password.

9.	 You will see your digital ID listed in the Security Sections 
window. 
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